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Nyheter

Nyheter i version 5.6.0 for programvaran TI-SmartView™ CE

TI-SmartView™ CE Nyheter
e TI-84 Plus CE standardemulatorns tillstand

OS version 5.6.0
Periodiska systemet version 5.5.0 uppdatering av grunddmnen
Python App version 5.5.0

Polynomial Root Finder och System Solver (Polynomrotsokare och
SystemldGsare) App version 5.5.0 - smarre fix

Science Tools (Naturvetenskapliga verktyg) App version 5.5.0 - uppdatering av

konstanter
Language Localization (Spraklokalisering) Apps - smaérre fix

Kom ihdg: Anvind senaste CE Bundle pa education.ti.com/84ceupdate for att garantera

att din CE raknare har de senaste och bast lampade raknarfilerna for din TI-84 Plus CE.

TI-SmartView™ CE for TI-84 Plus-familjen

Uppdatera till den senaste programvaran pa education.ti.com/84ceupdate for

forbattringar och CE-emulatorn med de senaste raknarfilerna for den har releasen.

Nyheter
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Introduktion till TI-SmartView™ CE-programvaran

Med TI-SmartView™ CE-programvaran kan du visa en TI-grafrdaknare for hela
klassrummet. Tva arbetsomraden &r tillgangliga for att hjdlpa dig att forbattra dina
presentationer i klassrummet.

Arbetsomradet Riknaremulator

Har kan du:

e Visa en Full Emulator-skarm eller en Knappsats med stor skarm.
Med alternativa vyer for att Oppna eller stanga.
e Tangenttryckningshistorik
L
— Visar bilder av nedtryckta tangenter sa att elever kan folja

med i tangenttryckningarna.

e  View3™

— Lararkontrollerad uppdatering av upp till tre ytterligare
emulerade skarmar sasom Graf, Tabell och Ekvation fér
flera representationer.

e Berdkna och plotta
— Samma upplevelse som pa en fysisk grafréknare.
e Dra och slapp en emulerad skarm till din programvara for
klasspresentation.**
— Bygg ut dina lektioner med skdrmar som skapats under din
undervisning.
e Tryck pa emulatortangenter med en Fjarrknappsats!

—  Kor SmartPad™ CE-appen*** pa din TI-84 Plus CE ansluten
till datorn med din USB-kabel. Nar fonstret TI-SmartView™
CE &r i fokus pa din dator blir din rdknare en Fjarrknappsats.

e Oppna ett separat Screen Capture-fonster
m — Infanga och spara emulatorskarmar som datorfiler liknande
Tl Connect™ CE Screen Capture, som infangar skarmbilder
fran grafraknaren.

** Programvara sasom Microsoft™ Office eller annan presentationsprogramvara
stods.

***Appen SmartPad™ CE for TI-84 Plus CE kommer forladdad pa raknaren. Om inte
appen SmartPad CE finns pa din TI-84 Plus CE, sa finns den dven tillganglig for
nedladdning till din raknare fran education.ti.com/84ceupdate.

Obs: Skarmen Large Display ar inte pekaktiverad. Anvand emulatortangenter som pa
raknaren.
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Skdarmen Riaknaremulator

[

 for the T1-84 Plus Family
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Key Press History

Introduktion till TI-SmartView™ CE-programvaran 3



Arbetsomradet Emulatorutforskare

Har kan du:

Lagg till enstaka eller flera filer till emulatorn for installning infor dina
lektioner:

— Dra valda raknarfiler och/eller dina bilder (jpg, png, etc.) fran din
dator till emulatorn fér snabb emulatorinstallning dven under
lektioner.

Spara filer fran emulatorn for att spara till eller dela med dina
elevrdknare:

— Dra valda raknarfiler till din dator for att spara filer fran en
klasspresentation.

— Tips: Nar filerna har sparats till din dator kan du dra dessa filer till
anslutna elevrdaknare med Tl Connect™ CE Calculator Explorer for
klassrumsdelning. TI Connect™ CE ar fri for nedladdning fran
education.ti.com/downloads.

Standardskidarmen Emulatorutforskare

File Edit View Actions

5
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Anvanda arbetsomradet TI-SmartView™ CE
Raknaremulator

Arbetsomradet TI-SmartView™ CE Raknaremulator innehaller verktyg som du kan
anvanda for att mata in berdkningar, plotta variabler och visa grafer, tabeller och listor.

[ TI-SmartView™ CE for the TI-84 Plus Family
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Omrdden i fénstret TI-SmartView™ CE Software

o File Edit View Actions Help

Menyfélt - Anvand dessa menyer for att utfora alla emulatorfunktioner, inklusive:

e File (Arkiv) - filhantering e Actions (Atgarder) - sdsom infanga skiarm
e Edit (Redigera) - inkludera

kopiera tangent som e Help (Hjalp) - Hjalp och lankar

typsnitt
e View (Visa) - andra

skdrmarna

Anmdrkning: Du kan utfdra de flesta atgarder pa dessa menyer genom att klicka
pa ikoner i verktygsfaltet.

2l 5 o= 6

Verktygsfalt - Anvand dessa verktygsikoner for att:
e Vilja en annan raknarmodell
e Vixla visning av Stor skarm, Knapptryckningshistorik Pa eller Av samt View3™

e Infanga aktuell emulatorskdarm

Arbetsomradespanel - Anvand denna panel for att navigera mellan
arbetsomradena Calculator Emulator (Raknaremulator) och Emulator Explorer
(Emulatorutforskare).

o Vilj positioner for Emulator och Verktygsfalt

3
e Emulatorposition vianster/hoger & for att vaxla mellan vanster- och
hégerhandsvisning av grafraknarens skarm. Detta ar praktiskt vid projicering
av en interaktiv skrivtavla.

e Verktygsfilt topp/botten =l for att flytta verktygsfaltet mellan skdarmens
Over- och underdel. Detta ar praktiskt vid projicering av en interaktiv
skrivtavla.

Obs: Du kan dndra den visuella layouten och/eller positionen foér element for att

optimera atkomsten, sarskilt nar du anvander en interaktiv skrivtavia.

@ Emulatorpanel - Anvind denna panel for att anvanda denna fulla emulatorvyn
eller endast emulatorknappsatsvyn.

@ Stor skdrm / Knapptryckningshistorik - Anvind denna panel fér att visa en stor
raknarskdrm och/eller visa knapptryckningshistorik.

Du har féljande visningsalternativ:

e Large Display Screen only e Key Press History only (Endast
(Endast Stor skdrm) Knapptryckningshistorik)

e Large Display Screen + Key Press
History (Stor skarm + e Hide panel (Dolj panel)

Knapptryckningshistorik)
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0 View3™-panel - Anvand denna panel for att samtidigt visa ytterligare tre

skdarmar. (Som forinstéllning dr denna panel dold. Klicka pa E for att visa
View3™-panelen.)

Du kan valja tre av foljande skdarmar:

e Equation (Ekvation e List (Lista) e  Window
("Y="-editor)) (Stat List-editor)) (Fonster)

e Table (Tabell) e Stat Plot e [Blank]
(Statistikplottning) ([Blank])

¢ Graph (Graf)

@ Andra storlek pa Paneler - Klicka pa och dra den vertikala listen pa sidan av en
panel for att andra dess storlek.

Anvinda tangentbordet i TI-SmartView™ CE Emulator
Musen ersatter ditt finger vid tangenttryckningar pa datorns tangentbord.

Klicka pa tangenterna pa TI-SmartView™ CE-emulatorn pa samma satt som du skulle
trycka pa tangenterna pa grafraknaren.

1. Klicka pa piltangenterna pa emulatorns tangentbord for att flytta markoren
till 6nskad plats.

entry solve

"y

enter
2. Klicka pa « 2 for att vélja den.

Du maste forst stilla in tangentbordet i alfabetiskt skrivliidge for att skriva text med
datorns tangentbord.

Som forinstallning ar grafraknarens tangentbord i sitt normala lage, vilket innebar att
tangenterna helt enkelt ar kortkommandon for grafraknarens tangenter.
Att till exempel trycka pa [A] pa din dators tangentbord &r detsamma som att klicka pa

test

m pa grafriknaren. | detta lage kan du inte skriva in bokstdverna A till O p3
grafraknarens skarm genom att skriva dessa bokstaver pa datorns tangentbord.

A-lock

For att skriva in en bokstav eller annat alfatecken, klicka forst pa m pa
grafraknarens tangentbord (eller tryck pa [F7] pa datorns tangentbord) for att stilla
raknaren i alfaldge. Om du till exempel skriver [F7] [A] pa datorns tangentbord sa
skrivs ett A in pa grafraknarens skarm. Nar du har skrivit in tecknet atergar
tangentbordet till sitt normala lage.

Du kan I3sa alfatangenten for att skriva flera tecken i foljd.

For att Iasa alfatangenten:
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A-lock

» Klicka pa m m pa grafraknarens tangentbord eller tryck pa [F6] [F7] pa
datorns tangentbord.

For att aterga till normallaget:
» Klicka eller tryck pa [F7].

Att i alfaldge trycka pa [0] till [9] pa datorns tangentbord fungerar som
kortkommandon for de alfafunktioner som &r associerade med dessa tangenter pa
grafraknarens tangentbord. Trycker du pa [1] sa skrivs Y (alfatecknet associerat med
(1]) in pa grafriaknarens skidrm. Fér att skriva in ett tal, se till att tangentbordet inte &r i
alfaskrividge. Dessa tangenter skriver in siffrorna 0 till 9 i normalldget.

Du kan halla ned en piltangent for att kontinuerligt bladdra med markéren.

Nar du anvdander en piltangent for att flytta markéren kan du halla tangenten nedtryckt
for att utan uppehall flytta markoren i stallet for att trycka pa tangenten upprepade
ganger. | tangenttryckningshistoriken och i ett skript har symbolen for en upprepande

E‘o fast vid sig

Na&r du trycker pa en piltangent flera ganger i rad visas en pil med en
repetitionsraknare.

piltangent en klocksymbol

Na&r du trycker pa en piltangent flera ganger i rad visas en piltangent i

% 9
knapptryckningshistoriken. Denna piltangent, o , har ett nummer fast vid den som
visar hur manga ganger piltangenten har tryckts ned.

Tips: Nar du sparar langs grafer, eller anvander applikationen Cabri™ Jr App for att rita
geometriska former, kan du med pilarna pa datorns tangentbord fa en jamnare rérelse
jamfort med att anvanda en mus for att klicka pa emulatorpilarna.

Dra och sléiippa en skérm till en annan applikation

Du kan dra och slappa och klistra in valfri skarm i TI-SmartView™ CE i en annan
applikation.

Skdrmarna i TI-SmartView™ CE som du kan dra och klistra in inkluderar féljande:

e Skdrmen ovanfor tangetbordet i Emulatorpanelen
e Storskdrm
e Skdrmari View3™-panelen
Obs: Du kan dra en View3™-skarm till Screen Capture och anvanda Screen Capture

som en historik 6ver viktiga skarmar under en lektion.

e Sparade och ej sparade infangade skdarmbilder

8 Anvinda arbetsomrddet TI-SmartView™ CE Riknaremulator



Ansluta en réiknare som en fjdrrknappsats

Appen SmartPad™ CE ar tillganglig for TI-84 Plus CE. For att anvanda
TI-84 Plus CE som en fjarrknappsats for TI-SmartView™ CE:

1. Appen SmartPad™ CE for TI-84 Plus CE kommer forladdad pa raknaren. Om inte
appen SmartPad CE finns pa din TI-84 Plus CE, sa finns den aven tillganglig for
nedladdning till din réknare fran education.ti.com/84ceupdate.

2. Anslut din TI-84 Plus CE till datorn med en USB-datorkabel som medfdljde din
raknare.

3. Starta TI-SmartView™ CE. Se till att TI-SmartView™ CE-fonstret ar aktivt genom att
klicka pa TI-SmartView™ CE-fonstret.

4, Kor appen SmartPad™ CE pa din TI-84 Plus CE. Tryck pa [apps] och vdlj SmartPad™
CE pa Apps-menyn. Las informationen pa skarmen.

SmartPad™ CE SmartPad™ CE
for TI-SmartView™ CE for TI-SmartView™ CE
... HESLTI@UNPLUG USE CABLE ST UNPLUG USB CABLE
COHPUTER HINDOH OF EMULATOR COMPUTER HINDOH OF EMHULATOR
HUST BE SELECTED HUST BE SELECTED
TO PRESS EHULATOR KEYS T0 PRESS EMULATOR KEYS

5. Tryck pa tangenterna pa raknarens knappsats som fjarrstyr emulatorns tangentbord
pa TI-Smartview ™ CE.

6. Koppla loss USB-kabeln fran raknaren for att stoppa appen och funktionen for
fjarrknappsats.

7. Du kan behova ansluta USB-kabeln och kéra appen pa nytt om anslutningen for
fjarrknappsatsen inte langre svarar.

Anmarkning:
e TI-84 Plus CE som kor appen SmartPad™ CE visar inte berakningar eller grafer.
Réknaren fungerar da enbart som en fjarransluten USB-knappsats for emulatorn.

e TI-84 Plus CE forblir en fjarrknappsats nar fonstret TI-SmartView™ CE ar aktivt.
Klicka pa TI-SmartView™ CE-fonstret innan du trycker pa réknarens tangenter.

e Tl SilverLink-kabeln stods ej i TI-SmartView™ CE.
USB-datorkabel

Du maste anvdanda USB-datorkabeln som medféljer din TI-84 Plus CE grafréknare for
att anvanda appen SmartPad™ CE. Andra Tl-anslutningskablar stods ej.

Anvdnda arbetsomradet TI-SmartView™ CE Rdknaremulator 9
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Ytterligare information om anslutningsmdjligheter

Menyn Emulator Link - Ingen siandning/mottagning

Link-funktionen, link] p4 emulatorerna &r avaktiverad. For att ldnka filer mellan
en ansluten raknare och en emulator, anvand Calculator Explorer i TI Connect™ CE
och Emulator Explorer i TI-SmartView™ CE.

Dra forst raknar- eller emulatorfiler till datorn vid 6verforing mellan Emulator
Explorer i TI-SmartView™ CE och Calculator Explorer i TI-Connect™ CE.

Tl-SilverLink-kabel

Tl SilverLink-kabeln stods ej i TI-SmartView™ CE.

Aterstilla en riknare fran TEST MODE (testldges)instélining
TI-SmartView™ CE 6verfor inte en fil till en ansluten raknare.

For att avsluta instillningen PROVLAGE, anvind ett av dessa sétt.

- Anslut en CE till den senaste versionen av Tl Connect CE. Se
education.ti.com/84ceupdate

- Vilj Actions > Quit Exam Mode on Connected CE Calculators (Atgérder > Avsluta
provldge pa anslutna CE-T-raknare)

- Skicka en fil mellan tva raknare

- Anslut till den senaste versionen av Tl Connect CE och skicka en fil till en
ansluten minirdknare

10 Anvinda arbetsomrddet TI-SmartView™ CE Rdknaremulator
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Aterstdlla emulatorn

For att aterstédlla emulatorn:

1. Klicka pa Actions (Atgarder).

2. Klicka pa Reset Emulator (Aterstill emulator).
3. Klicka p3 Reset (Aterstill).

EN x|

Reset Emulator?

Resetting the emulator will overwrite all the
contents of the current emulator state, including al
items in RAM and Archive,

Do you want to reset the emulator?

CANCEL RESET

Aterstalla emulatorn:

e Skriver dver emulatorns aktuella status
o Aterstiller TI-SmartView™ CE-programvaran till fabriksinstallningarna

e Rensar tangenttryckningshistoriken

Uppdatera emulator-0S

Om det i framtiden finns en OS-uppdatering fér en CE-raknare men TI-SmartView™ CE-
emulatorn inte uppdateras s& kan emulatorn uppdateras med Actions (Atgirder) >
Update Emulator OS... (Uppdatera emulator OS....

TI-SmartView™ CE kraver en sarskild emulatortillstandsfil for att uppdatera emulator-
0S. Den finns pa education.ti.com/84ceupdate. Denna fil &r annorlunda jamfért med
filen du anvande for att uppdatera raknarens OS.

Anvinda arbetsomrddet TI-SmartView™ CE Riknaremulator 11
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Spara och lds in en CE-emulator Status

Nar du sparar ett CE-emulatortillstdnd skapas en fil som lagrar emulatorns
installningar med alla dndringar som du har gjort.

Du kan till exempel forbereda en klasspresentation genom att mata in funktioner i
"Y="-editorn och @ndra installningarna for Fonster och Zoom. Nar du sparar dina
andringar i en emulatortillstandsfil kan du helt enkelt Iasa in filen for att visa
presentationen. Om du vill skapa olika presentationer for olika klasser kan du skapa

flera tillstandsfiler for emulatorn.

Obs: Historik for tangenttryckningar, skdrmdumpar och emulatorns storlek sparas inte i
emulatorns tillstandsfil. Observera att tillstandsfilen fér CE-emulatorn kan vara stor.
Kontakta IT-avdelningen om lagringskapaciteten ar ett problem for dig.

Spara CE-emulatortillstandet

Att hantera, spara och ldsa in en fil for emulatortillstandet ar endast tillgéangligt for CE-
emulatorn. TI-84 Plus CE-emulatortillstandsfil kan endast ldsas in pa TI-84 Plus CE-

emulator.

1. Klicka pa Actions (Atgirder) > Save Emulator State... (Spara emulatortillstand...).

= TI-SmartView™ CE for the TI-84 Plus Family

File Edit View |Actions Help

RMAL FLOAT AUTO REAL RADIAN MP n

Capture Screen ctri+

s 11

Choose Data Collection Sensor ,
Save Emulator State...

2nd
Load Emulator State...
Adock

Update Emulator OS...
[

PeE u{ KL

2. | dialogrutan:
a) Navigera till den mapp dar du vill spara CE-emulatorns tillstandsfil.
b) Skrivin ett filnamn. Anvand ett namn som beskriver CE-emulatorns tillstand.
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CE-emulatortillstandsfilen har ett férkonfigurerat filnamn TI84PCE Emulator State_
OS x-x-x_date.s84 dar filtillagget, *.s84 indikerar att filen ar ett TI-84 Plus CE
emulatortillstdnd skapad med TI-SmartView™ CE-programvaran. En statusfil for
CE-emulator som skapats i TI-SmartView™ CE v5.6.0 eller senare kommer inte att
Idsas in pa tidigare versioner av TI-SmartView™ CE.

c) Klicka pa Save (Spara).
Lasa in ett CE-emulatortillstand

Eftersom CE-emulatortillstandsfilerna ar specifika for varje raknarmodell kan du endast
lasa in en emulatortillstandsfil for den aktiva raknarmodellen.

1. Klicka p& Actions (Atgirder) > Load Emulator State (Lis in emulatortillstand).

EI TI-SmartView™ CE for the TI-84 Plus Family

File Edit View |Actions Help

RMAL FLOAT AUTO REAL RADIAN MP n

Capture Screen crl+T
oot 11
Choose Data Collection Sensor y
.

Save Emulator State..

Load Emulator State...
Adock

Update Emulator OS..
st A

Reset Emulator
e ——
u

L Jd{ K} Le

2. | dialogrutan:
a) Navigera till den mapp som innehaller emulatorns tillstandsfil.

Obs: Endast CE-emulatortillstandsfilerna for den aktiva raknarmodellen visas.
b) Klicka pa namnet pa CE-emulatorns tillstandsnamn for att markera filen.

c) Klicka pa Open (Oppna).
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Viilja ett visningsalternativ

Du kan anpassa ditt visningsfonster sa att det visar eller doljer tillvalspaneler och dndra
typen av information som visas i dem. Som forinstallning visar TI-SmartView™ CE-
programvaran raknaremulatorns arbetsomrade i ldget Large Screen (Stor skdarm).

Visa rdaknarskdarmen

1. Klicka pa E forattvisa 2. Klicka pa E for att visa skdrmen

raknarskarmen ovanfor Knappsats + Stor skdarm.
tangetbordet i
Emulatorpanelen.

NORMAL FLOAT AUTO REAL RADIAN MP n

Vilja en emulatortyp

Klicka pa nedatpilen pa for att vélja en emulatortyp.

-84 Plus CE

TI-84 Plus
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TI-84 Plus CE
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Byta raknarens framstycke

For att byta framstycket:

1. Klicka pa View (Visa).

2. Hall markoren 6ver Calculator Faceplate (Riaknarframstycke).

3. Klicka pa namnet pa ett raknarframstycke.

Ljus Kontur Mork

EEEEE ==
oEn w =)
mim e =
mamumkﬁ'
CT-1-1-1]
DEmn .
B E (w7 (el
BGeE "
B2

off catalog s i Pams 7 emysow catalog v i ans 7 onry soe
B o) el [ [o][ (e ][m

Visa eller délja tangenttryckningshistoriken

alpha ‘xm en| | stat

Klicka pa for att visa eller délja tangenttryckningshistoriken.
Klicka pa CLEAR (RENSA) i panelen intill tangenttryckningshistoriken for att rensa
historiken.

Key Press History o 5= T
=i ®
=
o Klicka har och dra for att andra Klicka har for att rensa
storleken pa tangenttryckningshistoriken.
tangenttryckningshistorikens
panel.

Né&r du trycker pa CLEAR ser du denna informationsruta:
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E, Key Press History = Py

Are you sure you want to clear the history?

CANCEL CLEAR

Kopiera tangenttryckningshistoriken till en annan applikation

Du kan kopiera alla eller utvalda delar av tangenttryckningshistoriken till en annan
z

Lz

applikation, t.ex. en ordbehandlare. Du kan kopiera tangentgrafik E] sasom den
visas i tangenttryckningshistoriken eller ocksa kan du kopiera tangenttryckningar som

typsnittstecken (5] (=] [6].

Anmarkning: Nar du kopierar tangenter som typsnittstecken anvdander dessa tecken
teckensnittet TI84PlusCEKeys. Detta typsnitt installeras automatiskt i din dator nar du
installerar TI- SmartView™ CE-programvaran.

Kopiera tangenter som grafik- eller typsnittstecken

1. Valj den eller de tangenter som du vill kopiera.
For att valja tangenter i tangenttryckningshistorikens panel anvander du en av
foljande metoder:

Knapp Metod
— En enda tangent: Klicka pa en tangent.
— Flera tangenter: Klicka pa en tangent.

Hall Ctrl-tangenten nedtryckt pa
datorns tangentbord.

Klicka sedan pa andra tangenter for att
vdlja fler.

— Flera tangenter i sekvens: Klicka pa en tangent.

Tryck och hall shift-tangenten
nedtryckt pa datorns tangentbord.
Tryck pa en annan tangent.

Obs: Du kan harigenom vilja de tva
tangenterna plus alla tangenter
mellan dem.

— Alla tangenter: Klicka pa en tangent.
Hogerklicka.
Klicka pa Select All (Vilj alla).

Anmirkning: S3 har ser en tangent ut fére och efter att du har valt den.
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Knapp | Metod

Fore: Efter:

L2 Z L2 Z

Hogerklicka pa de valda tangenterna.

Klicka pa Copy (for att kopiera tangenter som grafik).
- eller -
Klicka p& Copy As Font (for att kopiera tangenter som typsnittstecken). (5] [=] (6].

4. Vaxla till en annan applikation.

5. Klistra in tangenterna pa lamplig plats.

e Dukan ocksa dra de valda tangenterna som grafik till den andra applikationen.

e Du kan dndra storleken pa tangentgrafiken nar du har klistrat in dem i en ny
applikation.

e | vissa applikationer kan tecken inklistrade som typsnitt visas med det typsnitt som
anvands pa den aktuella platsen. Da kanske de inte alls ser ut som
grafraknartangenter. Vid behov, dndra till typsnittet TI84PlusCEKeys pa tecknen. Se
hjalpfilen for malapplikationen du anvander for information om hur du tillampar
ett typsnitt pa tecknen.

Visa panelen View3™

1. Klicka pa m for att visa

View3™-panelen.

2. Klicka pa titelfdltet pa varje skarm for att vdlja mellan dessa visningsalternativ:

— Ekvation — Lista — Fonster
("y="- (Stat List-editor)
editor)
—  Tabell — Statistikplottning — [Blank]
—  Graf

3. Klicka i den grona, lararkontrollerade uppdateringsknappen i View3™-panelen for
att uppdatera View3™-skdrmarna. Detta uppdaterar vyn for dina elever under

undersokningar.
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Uppdatering detekterad

Uppdaterar eller avbryt

Ingen uppdatering detekterad

4. Visa innehallet pa de valda skdarmarna, eller upprepa steg 2 for att andra skarmtyp.

Andra storlek pé TI-SmartView™ CE-skéirmen

Klicka pa och dra kanten pa en panel for att andra storleken pa panelerna Emulator,

Large Display (Stor skarm) eller panelen View3™.

[ = 1 Smanview™ Cfor the -84 Pus amily

Flle Edit View

Actions Help

B ma= @

LIRS ws TI-84 Plus CE

NORMAL FLORT AUTO REAL RADIMN 1P ]

Yi(-1)
4

gy
B -0,8414709848

[ JES[ENEal
[ ISRIESIESIES
[ Ixalew[icylcs)

o] S]]

fnoik 3 = sl E ik

Emhﬁganﬂ

calc 14 L1

L a1 s

cale 14 L2

@@n@h-@n

entry sove  statpiot 11

an

| —

£quation v
o Pt ot

nyiEx-s

B\V2Bsin(X)

N

Graph v
Foma.-rionr aura Reat taozan r- )

Anmarkning: Alla dessa ar vanster/hogeratgarder med undantag for
tangenttryckningshistoriken som ar dra upp eller dra ned.

Positioner for emulator och verktygsfilt

=0

projicering av en interaktiv skrivtavla.

Emulatorposition vinster/hoger - for att viaxla mellan vdnster- och
hogerhandsvisning av grafraknarens skiarm. Detta ar praktiskt vid

Verktygsfilt topp/botten - for att flytta verktygsfaltet mellan skarmens
over- och underdel. Detta ar praktiskt vid projicering av en interaktiv
skrivtavla.

]
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Alltid éverst

Vilj detta alternativ (Alltid 6verst) pa View-menyn for att halla TI-SmartView™ CE-
fonstren Gver andra 6ppna datorprogramvarufonster. Detta ar som att ha raknaren

liggande pa skrivbordet ovanpa dina papper! Placera fonstret pa ditt datorskrivbord dar
det bast uppratthaller "Always in Front".

FOr att stanga av "Alltid 6verst," valj menyobjektet pa View-menyn. Det finns ingen
verktygsikon for denna funktion och ingen indikator utéver menykryssmarkeringen nar
funktionen ar aktiv.

Obs:

Arbetsomradet TI-SmartView™ CE Emulator och Screen Capture-fonster kommer bada
att vara "Alltid 6verst" och vaxlar beroende pa deras position.

"Alltid 6verst" rekommenderas inte nar du har full skarmbild eftersom alla andra
fonster kommer att vara bakom den fulla skarmbilden av TI-SmartView™ CE.
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Anvanda Skarmdump

Du kan infanga den aktuella grafréaknarens skarmbilder med TI-SmartView™ CE-
emulatorns Screen Capture-verktyg.

For att anvanda funktionen Capture Screen:

» Klicka pa i verktygsfaltet.

Detta fonster 6ppnas:

E TI-SmartView™ CE Screen Capture

File Edit View Actions
O]

1 3 4
*Capture 1 @

MORHAL FLOAT AUTO REAL RADIAN MP n
"8cos(X)"3Y1
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Omrdden i fonstret Screen Capture

o

Infanga Klicka har for att infanga en bild av emulatorskdrmen:
Actions (Atgirder) > Capture Screen (och Capture Screen)
Anmarkning: En ram visas automatiskt runt varje skarmbild
nar du infangar den, men du kan ta bort ramen genom att
klicka pa View > Hide Screen Capture Borders (Visa> Gém
Screen Capture Borders). (Om du har flera bilder tar detta
bort ramen runt varje bild.)

Med Screen Capture kan du:

e infanga upp till 44 skarmbilder at gangen (for att infanga
ytterligare bilder, ta bort bilder fran fonstret Screen
Capture).

e automatiskt lagra infangade skarmbilder i minnet tills du
stanger huvudfonstret i TI-SmartView™ CE.

Nar du stanger Screen Capture uppmanas du att spara dina

infangade skdarmbilder. Du kan starta en ny Screen Capture-

session under en TI-SmartView™ CE-session.

Spara Klicka har for att spara valda infangade skarmbilder:
File > Save As(Arkiv > Spara som)

Kopiera Klicka har for att kopiera valda infangade skarmbilder till
klippbordet:

Edit > Copy (Redigera > Kopiera)

Ta bort Klicka har for att ta bort valda infangade skdarmbilder:
File > Delete (Redigera> Ta bort)

© O OO0

Andra storlek For punkten langs skalan for att justera storleken i
granskningen av den aktuella infangade skdarmbilden.
View > Scale Screen Captures (Visa> Skala Screen Fangar)
Obs: Skdarmar sparas for den aktuella procentsatsen i vyn.

6]

Andra namn Andra namnet p3 en infdngad skarmbild genom att markera
titeln och skriva in ett nytt namn.

o

Visa Visa infangade skdarmbilder har.

Dra och sléippa en skédrm till en annan applikation

Du kan dra och slappa och klistra in valfri skarm i TI-SmartView™ CE i en annan
applikation.

Skdarmarna i TI-SmartView™ CE som du kan dra och klistra in inkluderar féljande:

Skarmen ovanfor tangetbordet i Emulatorpanelen
Stor skarm

Skarmar i View3™-panelen

22
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Obs: Du kan dra en View3™-skarm till Screen Capture och anvdnda Screen Capture
som en historik 6ver viktiga skarmar under en lektion.

e Sparade och ej sparade infangade skdarmbilder
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Anvanda arbetsomradet TI-SmartView™ CE
Emulatorutforskare

Fran arbetsomradet Emulatorutforskare kan du hantera emulatorfiler, lagga till
innehall fran din dator till emulatorn och skicka valt innehall till din dator.

File Edit View Actions Help

=)
=] TI84PlusCE  RAM: 15218 available
NAME Tree v sz LocaTioN
IE
1N Window window 2108 RAM
1N RdWindw User Zoom Recall Window 209 8 RAM
1N Thiset Table Setup 208 RAM
[ Real List 28 RAM
[ T Real List 28 RAM
[ B Real List 28 RAM
) L Real List Y] RAM
1 s Real List 28 RAM
£} L Real List 28 RAM
@ Probsim Flash Application 71kB Archive
@ casyData Flash Application 167 kB Archive
@ celsheet Flash Application 123k8 Archive
@ Transfrm Flash Application 28kB Archive
@ cabrir Flash Application 102 k8 Archive
@ Periodic Flash Application 46kB Archive
@ sdtools Flash Application 54kB Archive
@ conics Flash Application 2kB Archive
@ eysmiz Flash Application 83 kB Archive
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Delar av huvudfénstret TI-SmartView™ CE Emulator Explorer

o 6 O

Lagga till raknarfiler fran dator till emulator.

Ta bort valda raknarfiler.

Uppdatera vyn 6ver emulatorns innehall.

Obs: Nar du andrar arbetsomradet till Emulator Explorer, uppdatera vyn
av emulatorfilerna for att uppdatera eventuella dndringar som gjorts i
emulatorn.

(1]
9 Skicka valda raknarfiler till dator.
(3]
(4]

Fran Emulatorutforskaren kan du kopiera emulatorfiler till din dator, och ta bort
datafiler och program fran din emulator.

Kopiera emulatorfiler till datorn

Du kan kopiera de flesta data, filer och program fran din emulator till din dator som
backup-filer och sedan skicka dessa till andra rdknare eller for att frigéra minne i
emulatorn.

Kopiera en fil fran emulatorn till datorn

1. Klicka pa filnamnet for att vdlja det.

al
2. Klicka pa .

- eller -
Dra och slapp filen i en mapp i din dator eller pa ditt skrivbord.

Kopiera en fil fran datorn till emulatorn

K
1. Klicka pa .
2

Navigera till 6nskad raknarfil i din dator.

Obs: Du kan ocksa dra dina bilder (.jpg, .png, etc.) for att konvertera till
emulator/riaknarbakgrundsbilder.

3. Klicka pa filen for att valja den.

4. Klicka pa Open (Oppna).
Ta bort emulatorfiler

Du kan ta bort data, filer och program fran din emulator.

Anvinda arbetsomrddet TI-SmartView™ CE Emulatorutforskare
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Ta bort filer fran emulatorn

1. Klicka pa filnamnet for att vdlja det.
2. Tryck pa III] .

Dataimport

Med funktionen Dataimport kan du konvertera/skicka kalkylprogramsdata sparade som
csv-datafiler till rdknaren som raknarlistor eller matrisfiler.

Du kan ta fram funktionen Dataimport fran arbetsomradet Calculator Explorer
(Réknarutforskare).

Viktiga funktioner:

e Skapa (eller ladda ned) ett kalkylark med data.

e Fore import, redigera data i din kalkylprogramvara for att endast tillata numeriska
raknarformat (specificeras nedan) for import till en raknarfil.

Om kalkylprogrammet

* Endast ett kalkylprogram sparat som en CSV-fil (Comma Delimited) (*.csv) kommer
att importeras at gangen via arbetsomradet Calculator Explorer.

* En kalkylprogramfil (csv) kan dras till Calculator Explorer eller importeras via
menyn Actions > Import Data (.csv) to Lists/Matrix....

e Upp till 6 raknarlistor eller 1 matris fran kalkylprogramsdata kommer att skickas till
den anslutna raknaren.

Regler for att forbereda kalkylprogrammet for import:

e Alla celler maste innehalla Reella Tal-data som de upplevs pa raknaren och ingen
text.

- Komplexa tal stéds inte for dataimport.

- Om decimaltal ar representerade med ett komma i *.csv-filen konverteras filen
inte med Data Import Wizard (Dataimportguiden). Kontrollera
nummerformateringen i din dators operativsystem och konvertera *.csv-filen
till att anvanda decimalpunkt. CE-raknarens list- och matrisredigerare anvander
nummerformat sasom, till exempel 12.34 och inte 12,34.

e Data maste starta i cell Al
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e Listimport: Om rdknarlistor dnskas:

£2 Import your Data b

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text.

Select calculator file type for conversion

FILENAME: total.csv

COLUMNS:

{~} Lists v 1 v

CANCEL CONTINUE

- endast sex kalkylprogramskolumner, A-F, kommer att importeras

- Kolumner kan ha en langd pa upp till 999 celler.

- Den forsta tomma cellen i en kolumn tolkas som slutet pa data for den
listimporten

e Matrisimport: om réaknarmatris onskas:

£2 Import your Data X

Prior to importing your spreadsheet saved in csv file format, make sure
your data starts in cell A1, contains only Real numeric values, and does
not contain text

Select calculator file type for conversion:

FILENAME: total.csv

[:] Matrix v 2 x|2 a

CANCEL CONTINUE

- Endast en matris kan importeras fran en kalkylprogramsfil.

- Upp till 400 celler kan importeras. (Exempel: rad x kol: 10 x 5 = 50 celler fran
radomrade 1-10, kolumner A-E.)

- Matrisens dimension i formen (rad x kolumn) kommer att begdras under
importforloppet i Calculator Explorer.

- Entom cell inom den specificerade matrisdimensionen kommer att tolkas som
0.

e Ha inte data i kalkylprogrammet utanfor de tillatna storlekarna for listor eller
matriser enligt ovanstaende beskrivning. Annars blir filen ogiltig nar du forsoker
med en dataimport till Calculator Explorer.
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Spara raknarlistor eller matrisfiler

e For att spara skapade raknarfiler till datorn, efter import/sandning till raknare, dra
list- eller matrisfilen fran Calculator Explorer till 6nskad datorplats.
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Kortkommandon pa tangentbord

Du kan anvédnda din dators tangentbord for att trycka pa en tangent i stéllet for att
trycka pa den tangenten pa TI-SmartView™ CE-tangentbordsbilden.

Till exempel:

Om du vill 6ppna "log"-funktionen pa emulatorns tangentbord, anvdnd tabellen nedan
for att hitta vilken datortangent du ska trycka pa.
s ]

[N]

» Tryck pa [N] pa din dators tangentbord (och observera att emulatortangenten
upptill till vanster ar alfabokstaven N.)

Obs: | vissa fall visas tangenten pa emulatorn nar du pa tangentbordsknappen pa
datorn. Ikonen Knapptryckningshistorik kanske inte visas forran vid nasta
knapptryckning.
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Kompatibilitet med grafréiknare
Se handboken Komma igang med din TI-84 Plus CE for kompatibilitet med grafraknare.

Anmdrkning: | regel ar grafraknarna T1-84 Plus CE kompatibla med andra TI-84 Plus- och
TI-83 Plus-modeller.

Appar, operativsystem och vissa datafiler med numeriska typer som ej stods delas inte
mellan modeller.

TI-Basic-program kan behéva modifieras for att korrekt visa hégupplosta
fargskarmsmodeller.
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Python Experience

Anvénda TI-SmartView™ CE fér att demonstrera Python Experience

Uppdatera till senaste TI-SmartView™
CE pa education.ti.com/84ceupdate.

Starta TI-SmartView™ CE version 5.6.0
eller hogre.

K&r Python App pa
TI-84 Plus CE emulatorn.

Python App erbjuder
— Filhanterare

— Redigering

— Exekvering av dina Python-
program i shell-granssnittet

SmartPad CE App trycker pa
knappsatsen fran fjarrplats nar Python
App kors.

Du kan skicka dina *.py-filer fran
datorn till arbetsomradet
Emulatorutforskare for att konvertera

= TI-SmartView™ CE for the TI-84 Plus Family — O

File Edit View Actions Help

Iz

7 on =i

TI-84 Plus CE

EDITOR: LINREGR n
PROGRAM LINE 0001 [=]
import ti_plotlib as plt

AP TEXAS INSTRUMENTS.

ﬂcur-r-er\t intensity

1—[ , 0.9, 2.1, 3.1, 8.9, 5.
su 7.1, 8.0, 9.2, 9.9,
110119]

# Convert milliamps to amps
for n in range (len(I)):
ooe

I[n] /= 1

Fns. [a A #]Tools| Run [Files

statpiot 11 thiset 12 format 3 calc 4 table 15

(v=_) (snaon] z00m] (woce ) orah]
quit ins
£3 D

Adock  link & st

@@
Ll o] et |

fest A angle B draw C distr

dina program till PY AppVars.

matrix D sin! E cos! F tan! G W

ﬂ-IIIIE
0 N u o v Pw Ql R
EB(7])(8](9 |[x]
o* s TL5 U s vl w
Em(4](5](6](=]
rcl X u Y 2 Z L 8 mem “
En (2 ](3])0F)

i ans 7 entry soive

[F B

Hub/Rover-program

Skapa ti_hub/ti_rover Python-program i CE-emulatorn nar Python App kors.

*Obs: Det finns ingen anslutningsbarhet mellan TI-SmartView™ CE och TI-
Innovator™ Hub eller TI-Innovator™ Rover. Program kan skapas och sedan koras
pa CE-T-raknaren.

Avsluta Python App for att forbereda 6verforing av Python AppVar(s) fran
emulatorn. Emulatorn far inte vara "upptagen” med att kéra en App eller ett
program for nasta steg.

Byt till arbetsomradet Emulatorutforskare och skicka programmet/n till datorn.

Anvand TI Connect™ CE for att skicka Python AppVars fran datorn till CE-T-
raknaren for TI-Innovator™ Hub/Tl-Innovator™ Rover experience.
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Obs: For att avbryta ett Python-program som kors i Shell-granssnittet, t.ex. nar ett
program ar i en kontinuerlig loop, tryck pa [on]. Tryck pa [Tools] [zoom] > 6:New Shell
([Verktyg] [zooma] > 6:Nytt shell) som en alternativ metod till att stoppa ett program
som kors.

Kom ihdg: For alla datorer/TI-Python experience: Efter att ha skapat ett Python-
program i en utvecklingsmiljo for Python pa datorn, validera att ditt program kan kéras
pa raknaren/emulatorn TI-Python experience. Andra programmet efter behov.

SmartPad CE App fjarrknappsats

— Nar den kors agerar SmartPad CE App pa din anslutna CE-T-rdknare som en
fjarrknappsats, inklusive den sarskilda knappsats-mappning som finns nar
Python App kors.

Arbetsomradet Emulatorutforskare

— Avsluta Python App sa att emulatorn inte ar aktiv nar du utnyttjar alla
funktioner hos arbetsomradet Emulatorutforskare.

— program.py < > PY AppVar konverteringar ér tillatna. Detta liknar TI Connect™
CE experience nar program skickas till den anslutna CE-T-rdknaren.

— Narenfil, program.py, som skapats i en annan Python-miljo skickas, maste PY
AppVar redigeras for att fungera som forvantat i TI-Python. Anvand Python App
Editor for att andra efter behov foér de unika modulerna sasom
ti_plotlib, ti_system, ti_hub och ti_rover.

Data Import Wizard (Dataimport-guide)

— *.csv-filer med data, formaterade som det anges i guidens dialogruta,
konverterar data till listvariabler i CE. Metoder i ti_system kan sedan anvandas
for att dela listor mellan emulator CE OS och Python App. Den héar funktionen
liknar den i Data Import Wizard (Dataimport-guide) i TI Connect™ CE.

- Om decimaltal ar representerade med ett komma i *.csv-filen konverteras filen
inte med Data Import Wizard (Dataimportguiden). Kontrollera
nummerformateringen i din dators operativsystem och konvertera *.csv-filen
till att anvanda decimalpunkt. CE-raknarens list- och matrisredigerare anvander
nummerformat sasom, till exempel 12.34 och inte 12,34.
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Datainsamling med appen Vernier EasyData® pa
emulatorn for TI-84 Plus CE

Med appen Vernier EasyData® CE kan du anvdnda datainsamling pa emulatorn for TI-
84 Plus CE. Appen Vernier EasyData® CE for TI-84 Plus CE &r forinstallerad pa
emulatorn i TI-Smartview™ CE. Med appen kan du samla in enstaka sensordata pa
liknande satt som med raknarens app.

Tips:

e Se till att du ar bekant med datainsamling med appen EasyData® pa rdaknaren
innan du anvander TI-SmartView™ CE for att samla in data.

e Setill att du ar bekant med menyn (File>New) for appen EasyData® CE eller
kortkommandot Scan. Du kommer att anvanda dessa funktioner i emulatorn for att
ansluta en sensor till emulatorn medan sensorn ar ansluten till datorn.

Anvéinda Vernier-sensorer med TI-Smartview ™ CE och appen
EasyData® CE

Om du redan anvander Vernier-sensorer med TI-84 Plus CE eller med produktfamiljen
TI-8 med en mini USB-port, kan sensorerna anslutas till raknarens mini USB-port.

Vernier-sensorer som ska anvandas med produktfamiljen TI-8x (mini USB) behover ratt
adapter for att ansluta en vanlig USB-kontakt till datorn for att demonstrera
datainsamling.

Adaptrar

Sensortyp som ska anslutas till datorn

Namn Adapter Beskrivning

Easy to Go! Anvéand denna adapter for anslutning av
EasyTemp eller EasyLink™-adapter tillen dator
for datainsamling. Se mer

bl
Gollink Anvénd denna enkanals granssnittsadapter for
att ansluta de flesta av Vernier-sensorerna till
datorn. Se mer
Go!Motion Anvand denna kabel for att ansluta Go!Motion
till eller CBR 2 tillen dator. Den medféljer
datorkabel Go!Motion. Se mer
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Sensortyp som ska anslutas till riknaren

Namn Adapter Beskrivning

EasyLink™ Anvéand denna adapter for att lanka Vernier-

EdSyLink ‘\ sensorer till grafrdknaren TI-84 Plus CE.

" | EasyLink™ &r ett enkanals granssnitt som ansluts
tillUSB-porten pa grafrdknaren TI-84 Plus eller
handenheten TI-Nspire™. Se mer

Go'lto Easy Anvand denna adapter for att ansluta Go!Temp
Adapter eller Go!lLink™* till USB-porten pa handenheten
(mini USB) TI-Nspire™ eller grafréknaren TI-84. Se mer
(=

Go!Motion Anvand denna 72-tums kabel fér att ansluta en
tillraknarens Go!Motion eller CBR 2 till USB-porten pa
mini USB- handenheten TI-Nspire™ eller grafraknaren Tl-
port ﬁ £ 84. Kabeln har en USB-kontakt av typ mini-A

- 5

som ansluts till rdknaren och en vanlig USB-
kontakt av typ B som ansluts till Go!Motion eller
CBR 2. Kabeln medféljer CBR 2. Se mer

Vid anvandning for klassrumsdemonstrationer

Datainsamling med appen EasyData® stdds for klassrumsdemonstrationer endast pa
emulatorn for TI-84 Plus CE. Om din klass anvander nagon raknare ur produktfamiljen
TI-8x med den senaste versionen av appen Vernier EasyData®, kommer
demonstrationen av datainsamling med hjalp av TI-SmartView™ CE med TI-84 Plus CE
att vara jamforbar med upplevelsen pa TI-8x-rdknaren.

Datainsamling fran en sensor

Datainsamling fran en enda sensor stdds i emulatorn for TI-84 Plus CE (liknande
réaknaren TI-84 Plus CE).

Om sensorn stdds av appen EasyData® App pa raknaren via mini USB-kontakten, blir
emulatorn i TI-Smartview ™ CE ett demonstrationsverktyg for datainsamling som liknar
upplevelsen pa rdaknaren.

e (CBR 2™ (Calculator-Based Ranger™) stods med USB-kabeln.
e (CBL 2™ (Calculator-Based Laboratory™ system) stéds inte.

e Den senaste versionen av appen Vernier EasyData® CE for TI-84 Plus CE ar
forinstallerad i emulatorn.

e Aldre versioner av appen ar blockerade i Emulator Explorer fér att f& den bésta
upplevelsen av datainsamlingen.
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Anviéinda TI-SmartView™ CE for att demonstrera datainsamlingen
1. Starta TI-SmartView™ CE.

Tips: Om du kér ndgon annan programvara som ocksa samlar in data med hjalp av
Verniers USB-sensorer, rekommenderar vi att du stdanger alla andra
datainsamlingsprogram sa att TI-Smartview ™ CE kdnner igen den valda sensorn
for denna datainsamling. Annars kommer din dators operativsystem att
"bestamma” vilken sensor som ska kdannas igen. Du kanske inte ser din sensor som
ansluten till TI-SmartView™ CE férran du stanger andra program.

2. Klicka pa nedatpilen pa for att valja en emulatortyp.

3. Anslut en sensor till datorn via en vanlig USB-port.

Avancerade funktioner: Du kan ha flera sensorer anslutna till dina datorportar. Du
kan anvanda menyalternativet (Actions>Select Data Collection Sensor) i TI-
SmartView™ CE for vaxla mellan sensorerna. Anvand menyn (File>New) pa appen
EasyData® CE for att ansluta nya sensorer till emulatorn.

4. Kor appen EasyData® pa emulatorn for TI-84 Plus CE.

Obs: Uppdatera alltid till senaste TI-SmartView™ CE pa
education.ti.com/84ceupdate. Den senaste EasyData appen kommer att laddas i
den senaste versionen av TI-SmartView™ CE.

5. EasyData® startar pa emulatorn. Du bor se namnet pa sensorn (eller
lankanslutningen) pa valkomstskdarmen. Sensornamnet visas sedan i matarskarmen
pa ett liknande satt som i raknaren.

Om appen EasyData® inte kdnner igen den anslutna sensorn till datorn kan du
anvadnda antingen Scan eller File>New i appen EasyData® pa emulatorn for att
ansluta sensorn.

6. Anvand funktionerna i appen EasyData® App pa samma satt som med CE-
emulatorn for att samla in och analysera data.

7. Avsluta appen (QUIT) EasyData® i emulatorn nar datainsamlingen ar genomford for
att fortsatta anvanda TI-SmartView™ CE.

e Data fran datainsamlingen lagras i emulatorns listor nar du avslutar appen
EasyData® CE.

e Du kan lata sensorn vara ansluten till datorn sa lange du behdover.
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Medan appen EasyData® CE kérs pa CE-emulatorn kan du gora féljande:

Byta Du kan byta emulator medan EasyData® kérs men
arbetsyta pa  dataexperimentet stoppas och sensorn kopplas bort fran
emulatorn CE-emulatorn som kor appen EasyData®. Nar du atergar till

CE-emulatorn, kommer du att fa ansluta sensorn pa nytt
till appen EasyData® CE med antingen File>New eller
kortkommandot Scan i appen EasyData® och pabdrja en ny
datainsamling. Det &r inte sdkert att féregaende
experiments data lagras. Avsluta alltid appen EasyData®
med QUIT for att lagra experimentdata till emulatorns
listor.

View3™ och  View3™ ar inte tillgénglig (avaktiverad) for alla appar
appar férutom appen Inequality Graphing.
View3™ visar endast skdrmar fran operativsystemet ™ och
visar inte app-skdarmar. Vi rekommenderar att du behaller
View3™ stangd nar du inte anvander funktionen eller da
den &r avaktiverad som nar de flesta appar kors pa

emulatorn.
Byta till Om EasyData® kors i CE-emulatorn och du behéver
arbetsytan anvanda Emulator Explorer, avsluta da forst appen
Emulator EasyData® och anvand darefter Emulator Explorer.
Explorer
Infanga Du kan infanga skarmbilder fran appen EasyData® under
skirmbilder tiden som ett experiment utférs med Screen Capture.
Sting och Du kan stdanga TI-SmartView™ CE medan EasyData® kors
oppna pa men dataexperimentet stoppas och sensorn kopplas bort
nytt fran CE-emulatorn som kor appen EasyData®. Nar du
TI- atergar till CE-emulatorn, kommer du att fa ansluta
SmartView™ sensorn pa nytt till appen EasyData® CE med antingen
CE File>New eller kortkommandot Scan i appen EasyData® och

paborja en ny datainsamling. Det ar inte sdkert att
foregaende experiments data lagras. Avsluta alltid appen
EasyData® med QUIT for att lagra experimentdata till
emulatorns listor.

Ytterligare hjalp

Om du behéver mer hjadlp med att anvanda appen EasyData® med raknaren for att
samla in data, finner du mer information i
http://www2.vernier.com/manuals/easydata_guidebook.pdf.
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Allman information
Onlinehjdlp

education.ti.com/eguide

Vilj ditt land for mer produktinformation.

Kontakta TI-support

education.ti.com/ti-cares

Valj ditt land for tekniska- och andra supportresurser.

Service- och garantiinformation

education.ti.com/warranty

Vilj ditt land for information om garantins langd och villkor eller om produkttjansten.
Begrdnsad garanti. Denna garanti paverkar inte dina lagstadgade rattigheter.
Uppdateringar

education.ti.com/84ceupdate
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